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Welcome 
Welcome to RAILER® 

Welcome to RAILER® Version 6.0. 
 RAILER is a member of the 
Sustainment Management System 
(SMS), a family of software 
products that includes PAVER, 
ROOFER, and BUILDER.  RAILER 
is a railroad track asset 
management system designed as 
a decision support tool for 
evaluating track conditions and 
planning track sustainment, 
restoration, and modernization 

(SRM) activities on military, short line, and industrial track networks.  RAILER 
combines railroad engineering technology; infrastructure management principles; 
model, standards, and analysis procedures; and computer speed and power into 
a decision support tool. 
 
 
 
 
 
 
 
 
The RAILER® Sustainment Management System 
 

There are thousands of miles of military, short line, and industrial railroad 
track that serves a vital role in transportation for the Department of Defense 
and the private economy.  Due to lower speeds and frequency of use, this 
track has maintenance and management requirements which typically differ 
from the large Class I commercial railroads.  However, in order to ensure 
this safe and reliable mode of transportation, and protect the nation’s 
investment, these track networks still need to be periodically inspected and 
continually maintained cost efficiently.  RAILER® SMS is a knowledge-
based track management program that gives planners decision support in 
the sustainment, restoration, and modernization (SRM) of their track 
network.  It combines condition assessment, work plan generation, and 
spatial analysis through a companion Geographical Information System 
(GIS) program to help provide support for informed decisions to managers. 
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The first step in the RAILER® implementation process is the creation of 
track inventory.  This is a physical survey of what makes up the track 
network, and includes pertinent information about the rail, ties, switches, 
culverts, curves, grades, grade crossings, etc.  A key part of this inventory 
process involves establishing a track naming convention and stationing 
scheme.  The stationing helps to establish a reference point and location 
for each track.  It also makes it easier to locate defects during the 
inspection and subsequent repair.  Once the inventory is collected, a 
detailed inspection of the track is done to identify, locate, and record track 
defects.  RAILER® links each recorded defect to 1) operations restrictions 
and maintenance levels based on governing standards, 2) a Track 
Structure Condition Index (TSCI) metric relating physical quality and 
condition, and 3) local work actions to correct the defect. 
 
This information is used to make informative decisions in the development 
of efficient short and long-range work plans.  Using the TSCI and the track 
standards with a customized set of business rules and prioritization 
schemes, managers can use the software to narrow down a long list of 
deficiencies to a filtered list of the most important work based on the 
condition and operations for the track.  The RAILER® process provides 
important decision support to engineers and facility planners with the 
following key information: 

• What rail assets exist. 
• What defects and deficiencies exist and costs to fix. 
• What restrictions are imposed – and the effect on operations and 
readiness. 
• What the physical track health/condition is (IRS ratings). 
• Short and long term maintenance strategies showing costs and 
effects of funding levels. 
• Assists both installation and HQ level decision support through 
objective and consistent metrics (garrisons can be compared equally) 

 
RAILER® RED 
 

RAILER® Remote Entry Database (RED) is provided with the RAILER® 
SMS software to allow for electronic collection of inventory and inspection 
information while in the field.  This software can be installed on a tablet PC 
for quick, accurate, and easy data collection for direct upload into RAILER® 
software when back at the office. The RAILER® RED software also 
displays defect findings from a previous inspection for verification if the 
defect was fixed or still remains. In addition, it displays the operating 
restriction for a recorded defect in real time based on the governing track 
standard. 

 
Benefits of Implementing and Using RAILER®  

• Knowledge of track inventory 
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• Structured inspection approach tailored to management need  
• Use of RAILER® RED for track inventory and inspection data 
collection  
• Instant access of stored information through reporting features 
• Tabular and graphical condition comparison to various track 
standards and a condition index scale  
• Establish deterioration rates for ties, rail, ballast, and the track as a 
whole  
• User-specified maintenance and repair policies and costs  
• Rapid estimates of work requirements  
• Structured approach to prioritize work based on user-set criteria  
• Ability to develop work plans, including specific projects  
• Ability to display track information on a map display through GIS  

 

What's New in Version 6.0 
RAILER® version 6.0 has undergone a complete upgrade from the previous 
version 5.3.  If you are familiar with previous versions, you will notice many 
changes in program layout and navigation from V5.3.  RAILER V6.0 is developed 
in the latest Microsoft .Net 2.0 technology, significantly improving the speed and 
performance of the software.  In addition, many new features have been 
incorporated into version 6.0.  Some of the most notable are: 
 
Network Hierarchy Navigation Tree  A network hierarchy tree is available to 
view the groupings of areas, tracks, and track segments in a user-friendly 
fashion.  Track and segment information, inventory information, and inspection 
information can also be quickly viewed and edited from this tree at the click of a 
button, greatly enhancing the program navigation. 
 
Track Copy Feature  The program now supports copying an entire track, 
including segment and inventory information to quickly create tracks of similar 
structure. 
 
Enhanced Work Planning Module  The RAILER work planning module has 
been streamlined to improve both usability and flexibility.  Work Planning setup 
and configuration follows a standardized process of creating cost books, policies, 
standards, prioritization schemes, and inflation factor sets that can be used as 
input parameters in the creation of current year and multi-year work plans. 
 
Grade Crossing Condition Index Computation  The RAILER Grade Crossing 
Inspection module has been revised and new data elements added to support 
the computation of the Grade Crossing Condition Index (GCCI).  The GCCI 
follows the same CI scales as for Ballast, Ties, and Rail to represent physical 
condition on a 0-100 point measure. 
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Basics 
Converting a V5.3 database 
Due to the drastic changes between RAILER Version 5.3 and Version 6.0, a 
database conversion is necessary to continue using your existing V5.3 database 
in Version 6.0.  This will automatically be preformed the first time you attempt to 
open your V5.3 database in RAILER 6.0.  When converting the database, the 
following screen will appear: 
 

 
 
Simply chose the path and file name to save the converted database to, and click 
UPGRADE.  A new version 6.0 database will be created from your existing V5.3 
database. 

RAILER Menu 
The RAILER menu exists at the top of the program, and provides the user 
access to several basic functions.  The menu is broken down into 8 main 
categories: 
 

 
 
File  Commands for creating a new database, opening an existing database, or 
existing the program. 
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Work Planning  Access to work plan configuration screens such as costs, 
policies and funding, as well as access to Maintenance &Repair (M&R) plan 
generation screen. 
 
Analysis  Access to Condition Index (CI) Update command 
 
Reports  Access to Condition Index, Installation Status Report (ISR), and 
Standard Level reports 
 
Tools  Access to screens for setting up GIS, Importing/Exporting RAILER 
Remote Entry Database (RED) Data, security settings and users, and database 
options. 
 
Windows  Commands for arranging program windows in a cascade or tile 
format. 
 
Help  Access to electronic RAILER help table of contents, and additional info 
about RAILER. 
 

RAILER Toolbar 
The RAILER Toolbar is positioned at the top of each RAILER screen, and 
provides the user with several icons for quick access to basic actions on each 
screen. 
 

 
 
These actions include: 

 Close  Closes the active window 

 Save Saves all changes to a record 

 New Creates a new record 

 Copy Copies an existing record and all associated attribute 
data to a new record 

 Delete Deletes the active record showing on the screen 
 Add'l Info Opens a screen to provide optional additional information 

for an active record 

 Comments Opens a window for user to attach text comments about 
an active record 

 Images Opens a window for user to attach related images about 
an active record 

 Reports Displays options for running reports to display information 

6 



Basics 

about one or more records 

 Help Provides context sensitive help to user about information 
and functionality of active window 

 
Note:  If a given button is gray out or not available, its action is not valid at that 
time 

Comments 
RAILER allows users to specify comments to provide more information about a 
particular record.  Comments are available from the RAILER toolbar, and are 
applied to the active record on the screen.  The comments screen is shown 
below. 
 

 
 
Simply type in comments in the window as text, and click SAVE to save the 
comments.  Use comments whenever you want to expand on a given data entry 
or elaborate a description. 

Navigation Tree 
The RAILER navigation tree provides a user-friendly interface for viewing, 
navigating, and working with the rail assets in the database.  It consists of an 
expandable/collapse-able tree that breaks down the track network by areas, 
tracks, and segments.  In this way, it is very easy to view all tracks that belong to 
a certain area, and all segments that belong to a certain track.  In addition, a 
number of commands can be accessed by right-clicking on an area, track, or 
segment in the tree, as shown below. 
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For example, by right-clicking on a given track in the tree, the user can bring up 
track information, inventory, inspection, certification, or add segments, delete the 
track, etc.  The right-click menu is context sensitive depending on whether a 
segment, track, area, or network is chosen.  The tree provides the primary 
means of navigating through the different levels of the RAILER database and 
accessing the inventory or inspection information. 

Glossary of Common RAILER Terms 
Area:  A group of tracks with similar characteristics to be managed together 
 
BSCI: Ballast & Subgrade Condition Index 
 
Clearance:  Any permanent obstruction near the track right of way that 
potentially impedes the movement of a train. 
 
Condition Index:  An objective measure of the condition of a track, or segment, 
based on observed defects present 
 
Curves:  A change in horizontal track direction 
 
Drainage:  A culvert, ditch or other structure that diverts water away from the 
track structure 
 
GCCI: Grade Crossing Condition Index 
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GIS:  Geographic Information System, 3rd party tool to display RAILER 
information spatially 
 
Global Work Action:  Work Action to apply to an entire segment of track, 
regardless of defects present 
 
Grade:  A measure of the % incline of a portion of track 
 
Grade Crossing:  Material covering track to bring grade level with top of rail 
 
ISR: Installation Status Report, for Army readiness reporting 
 
Local Work Action: Work Action to correct a localized defect 
 
Network:  Encompassed all track at a site or installation 
 
Prioritization:  A method of objectively defining the relative importance of work 
items 
 
Rail Crossing:  A track component that allows 2 individual tracks to cross each 
other at the same grade 
 
RAILER RED: Remote Entry Database field inspection/data collection module for 
RAILER 
 
RJCI: Rail & Joint Condition Index 
 
Segment:  A portion of a track which serves as the basic unit for Maintenance & 
Repair issues 
 
Station:  The reference location at a discrete track point, measured from the 
beginning of the track 
 
TCI: Tie Condition Index 
 
Track :  A designated portion of the network with a natural begin and end point 
 
Track Structure:  The components that make up the track's ability to carry wheel 
loads, including subgrade, ballast, ties, rail, etc 
 
TSCI: Track Structure Condition Index 
 
Turnout:  Portion of track where two tracks diverge 
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Getting Started 
Creating a new Database 
RAILER stores data in an Microsoft Access 2000 database.  To create new 
RAILER database, select New Database from the File menu.  Chose the file 
name and location to save the database, and click Save. 
 

 
 

Opening an Existing Database 
To open an existing RAILER database, select Open Database from the File 
menu.  Chose the file name and location of where the existing database is at, 
and click Save. 
 

11 



RAILER SMS 6.0 User Manual 

 

Database Configuration 
The configuration screen under the Tools menu is shown below.  It provides 
configuration options for the user.  For version 6.0, the following are the available 
options: 
 
Disable Login and Password  Check to disable password protection for the 
database 
 
Ring Bell on Error  Check to ring bell when a RAILER error is produced 
 
Pop Up Tips For Tool Bar Button  Check to enable tool tip descriptions when 
cursor passes over a button 
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Note that Version 6.0 supports only English Units of Measure. 

Active Standards 
After creating a new database, it is necessary to specify which track standard 
applies for the database.  Active database track standards can be set from the 
Standards tab in the configuration screen accessed via the Tools menu. 
 
In version 6.0, the following track standards are available: 

• FRA 
• Navy Safety 
• U.S. Army 
• UFC (Tri-Service) 

 
The primary standard is the main standard for the database, and it is what 
inspection results and the work plan generation is shown against.  The primary 
standard establishes a condition level and associated action or restriction for 
each defect identified on the track.  For example, for the UFC (Tri-Service) 
Standard, the following defect condition levels exist (from least serious to most 
serious): 
 

• Defect Free  No defects exist. 
• Full Compliance  Defect does not require corrective maintenance or track 

restriction. 
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• Maintenance A  Maintenance action is required to correct defect on 
category A track, but no operating restriction is imposed. 

• Maintenance B  Maintenance action is required to correct defect on 
category A or B track, but no operating restriction is imposed. 

• Restricted Operations  Defect requires an immediate speed restriction 
be placed on track affected.  Restriction exists until defect is corrected. 

• Close to Traffic  Defect is so severe that affected track is closed to train 
traffic until defect is corrected. 

 
 

 
 
When a primary standard is chosen, that standard is used when displaying defect 
condition levels in the inspection and M&R screens.  As an option, up to 2 
additional secondary standards can be specified for use in reporting features. 

Setting up Users 
Each RAILER database user can be given their own Login name, Login 
password, and user privileges.  This gives each user customized data access 
rights. 
 
These rights include: 
 
Super User  Has comprehensive rights to all portions of the program and 
database, including the ability to add or delete users, and change user settings. 
 This is typically a database administrator. 

14 



Getting Started 

 
Modify Data  Has rights to add, delete, and modify data, including inventory and 
inspection information. 
 
Certification Official  For Navy Users, has access to certification screen for 
certifying track.  If a user is a certifying official, they are either specified as an 
inspector or certifier.  In the Navy, each track certification record must be signed 
by both the inspector and certifier. 
 

 
 
To create a new user (only applicable for users specific as Super Users): 

1. Click New User Button 
2. Type name in Login Name box 
3. Click Accept 

 
To delete an existing user: 

1. Select user from Login Name Drop Down List 
2. Click Delete User 
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Track Network Hierarchy 
Network 
The network information screen is accessible by right-clicking on the Network in 
the Navigation Tree, and choosing Information. 
 

 
 
The network information screen displays high level data about the track network. 
 This includes: 
 
Network TSCI  This is the comprehensive Track Structure Condition Index for 
the entire track network, and relates the general condition of the overall network. 
 The normal TSCI is a straight average of the TSCI for all tracks in the network. 
 The Weighted TSCI is an average of each track TSCI, weighted by the length of 
each track. 
 
Number Stats  Displays a count of the number of areas, tracks, and segments in 
the network. 
 
Total Track Length  Displays the total track feet and total track miles in the 
network. 

Areas 
The Area Information screen displays information about an area in the network. 
 It is accessed by right-clicking on that area in the navigation tree, and choosing 
Information.  To create a new area, right-click on the network in the tree, and 
chose Add Area.  To delete an area, right-click on the area to be deleted, and 
chose Delete Area (note that track and segments within area do not get deleted, 
they get assigned as unassociated tracks) 
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An area is a logical grouping of tracks, and so after an area is created, tracks can 
be associated to the area. 
 
To associate tracks with an area: 

1. Chose the track on the Track/Segment List box on the left 
2. Click Associate>> and the track will be included in the Area Association 

box on the right 
 
To disassociate tracks from an area: 

1. Chose the track from the Area Association box on the right 
2. Click <<Disassociate and the track will be included in the Track/Segment 

List box on the left. 
 
The area information screen displays the following data about the tracks in the 
area: 
 
Area TSCI  This is the comprehensive Track Structure Condition Index for the 
entire area, and relates the general condition of the overall area.  The normal 
TSCI is a straight average of the TSCI for all tracks in the area.  The Weighted 
TSCI is an average of each track TSCI, weighted by the length of each track. 
 
Number Stats  Displays a count of the number of tracks, and segments in the 
area. 
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Total Track Length  Displays the total track feet and total track miles in the area. 

Tracks 
The Track Information screen displays information about a designated track.  It is 
accessed by right-clicking on that track in the navigation tree, and choosing 
Information.  To create a new track, right-click on the network or an area in the 
tree, and chose Add Track.  To delete a track, right-click on the track to be 
deleted, and chose Delete Track (note that all segments, track inventory info, 
inspection data associated with the track will also be deleted.) 
 

 
 
The track name and track boundaries may be established based on engineering 
or Public works records, drawings, or track operations conventions.  It is 
recommended to establish a consistent and recognizable naming convention for 
tracks in the network.  Each track has a begin station and end station boundary, 
and track length is computed automatically by the program from that.  Each track 
also has an area ID which can be used to identify or specify which area (if any) 
the track belongs to. 
 
The following track information is also displayed: 
 
Track TSCI  This is the comprehensive Track Structure Condition Index for the 
track, and relates the general condition of the overall track.  The normal TSCI is a 
straight average of the TSCI for all segments.  The Weighted TSCI is an average 
of each segment TSCI, weighted by the length of each segment. 
 
Number Stats  Displays a count of the number of segments in the track. 

Segments 
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The Segment Information screen displays information about a track segment.  It 
is accessed by right-clicking on that segment in the navigation tree, and choosing 
Information.  To create a new segment for a track, right-click on the track in the 
tree, and chose Add Segment.  To continue adding additional segments to a 
track, simply click the New button  on the Segment Information screen toolbar 
to create a new segment record.  To delete a segment, right-click on the segment 
to be deleted in the navigation tree, and chose Delete Segment. (note that all 
inspection data associated with the segment will also be deleted.) 
 

 
 
Segments divide the track up into manageable units for inspection and work 
planning purposes.  Typically, segment boundaries on a track go from one switch 
point to another switch point, but segment boundaries can also be placed at 
grade crossings, mileposts, etc.  For practical purposes, it is suggested that 
maximum segment lengths be no longer than a one mile.  Segment boundaries 
should be continuous (ie there should be no gaps between segments). 
 
The segment information screen displays the condition measures for the 
segment based off of the most recent inspection results.  This includes: 
 
RJCI  Rail and Joint condition index for segment 
 
TCI  Tie condition index for segment 
 
BSCI  Ballast and subgrade condition index for segment 
 
TSCI  Track Structure condition index, which is the weighted average of RJCI, 
TCI, and BSCI for segment. 
 
Standard Level  This is the standard level for the segment based off of the 
primary track standard. 
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Inventory 
Track Structure 
Track structure inventory information for a given track is accessible by right-
clicking on the track in the navigation tree, and choosing Inventory.  The structure 
tab contains data describing the fundamental structure of the track, including rail 
and tie details, for a given location of track. 
 

 
 
A track's structure can change several times throughout the length of the track. 
 Each time the track structure changes, a structure record is created.  That 
record indicates the boundary station locations for that portion of track structure, 
as well as common attribute information about the structure as seen above.  To 
view the different structure records for a track, use the begin station drop box. 
 To add a new structure record, click the New  button and a blank record will 
be created.  To copy an existing record, click the Copy  button and the active 
record, along with its associated attribute information, will be copied over to a 
new record.  To delete the active structure record, click the Delete  button.  To 
specify optional additional information about a track structure record, click the 
Additional Info  button and the following screen will appear. 
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Turnouts 
Turnout inventory information for a given track is accessible by right-clicking on 
the track in the navigation tree, and choosing Inventory.  The turnout tab contains 
data for each turnout associated with a track.  Note that even though a turnout 
exists at the intersection of two tracks, it should be recorded in the inventory of 
the main track only. 
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A given track (especially ladder type tracks) can have several turnouts.  To view 
the different turnout records for a track, use the turnout ID drop box.  To add a 
new turnout record, click the New  button and a blank record will be created. 
 To copy an existing record, click the Copy  button and the active record, 
along with its associated attribute information, will be copied over to a new 
record.  To delete the active turnout record, click the Delete  button.  To 
specify optional additional information about a turnout record, click the Additional 
Info  button and the following screen will appear. 
 

 

Grade Crossings 
Grade Crossing inventory information for a given track is accessible by right-
clicking on the track in the navigation tree, and choosing Inventory.  The Grade 
Crossing tab contains a data record for each grade crossing in the track. 
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A particular track may contain several grade crossings.  To view the different 
grade crossing records for a track, use either the Begin Station drop box or the 
Crossing Name drop box.  To add a new crossing record, click the New  
button and a blank record will be created.  To copy an existing record, click the 
Copy  button and the active record, along with its associated attribute 
information, will be copied over to a new record.  To delete the active grade 
crossing record, click the Delete  button.  To specify optional additional 
information about a grade crossing record, click the Additional Info  button and 
the following screen will appear. 
 

 

Rail Crossings 
Rail crossing inventory information for a given track is accessible by right-clicking 
on the track in the navigation tree, and choosing Inventory.  The rail crossing tab 
contains a data record for each rail crossing in the track. 
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 particular track may contain several rail crossings.  To view the different rail 
 

A
crossing records for a track, use the Centerline Station drop box.  To add a new
crossing record, click the New  button and a blank record will be created.  To 
copy an existing record, click the Copy  button and the active record, along 
with its associated attribute information, will be copied over to a new record.  To
delete the active rail crossing record, click the Delete 

 
 button. 

Drainage 
Drainage inventory information for a given track is accessible by right-clicking on 
the track in the navigation tree, and choosing Inventory.  The drainage tab 
contains a data record for each drainage structure in the track. 
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A particular track may contain several drainage structures, including culverts, 
pipes, ditches, etc.  To view the different drainage items for a track, use the 
Location drop box.  To add a new drainage record, click the New  button and a 
blank record will be created.  To copy an existing record, click the Copy  
button and the active record, along with its associated attribute information, will 
be copied over to a new record.  To delete the active drainage record, click the 
Delete  button.  To specify optional additional information about a drainage 
structure, click the Additional Info  button to bring up the following window. 
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Bridges 
Bridge inventory information for a given track is accessible by right-clicking on 
the track in the navigation tree, and choosing Inventory.  The bridge tab contains 
a data record for each bridge that the track spans.   
 

 
 
To view the different bridge records for a track, use the Begin Station drop box. 
 To add a new bridge record, click the New  button and a blank record will be 
created.  To copy an existing record, click the Copy  button and the active 
record, along with its associated attribute information, will be copied over to a 
new record.  To delete the active bridge record, click the Delete  button. 

Appliances 
Appliance inventory information for a given track is accessible by right-clicking on 
the track in the navigation tree, and choosing Inventory.  The appliance tab 
contains a data record for each appliance associated with the track, including 
items such as car bumpers, wheel stops, derails, etc. 
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A particular track may contain appliance items.  To view the different appliance 
records for a track, use the Location drop box.  To add a new appliance record, 
click the New  button and a blank record will be created.  To copy an existing 
record, click the Copy  button and the active record, along with its associated 
attribute information, will be copied over to a new record.  To delete the active rail 
appliance record, click the Delete  button. 

Grades 
Grade information for a given track is accessible by right-clicking on the track in 
the navigation tree, and choosing Inventory.  The grade tab contains track grade 
information. 
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To view the different grade records for a track, use the Begin Station drop box. 
 To add a new grade record, click the New  button and a blank record will be 
created.  To copy an existing record, click the Copy  button and the active 
record, along with its associated attribute information, will be copied over to a 
new record.  To delete the active grade record, click the Delete  button. 

Curves 
Curve information for a given track is accessible by right-clicking on the track in 
the navigation tree, and choosing Inventory.  The curve tab contains track curves 
information. 
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To view the different curve records for a track, use the Begin Station drop box. 
 To add a new curvepy  button and the active record, along with its associated 
attribute information, will be copied over to a new record.  To delete the active 
curve record, click the Delete  button. 

Clearance 
Track clearance information for a given track is accessible by right-clicking on the 
track in the navigation tree, and choosing Inventory.  The clearance tab contains 
data describing track clearance issues affecting the track. 
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A particular track may contain several clearance issues, including both horizontal 
and vertical clearance.  To view the different clearance records for a track, use 
the Begin Station drop box.  To add a new clearance record, click the New  
button and a blank record will be created.  To copy an existing record, click the 
Copy  button and the active record, along with its associated attribute 
information, will be copied over to a new record.  To delete the active clearance 
record, click the Delete  button.  To specify optional additional information 
about a track structure record, click the Additional Info  button and the following 
screen will appear. 
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Detailed Inspection 
Ties Inspection 
Tie inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the tie inspection screen, right click on 
the segment of interest, then choose Inspection -> Detailed.  The tie tab contains 
a tally of tie defects for that segment on a given inspection date.  Tie inspection 
information can be viewed for any inspection on record in the database by using 
the Date drop down box, and choosing the date of the inspection.  Note that the 
Defect Free check box is used to denote the segment as inspected and 
completely free of tie defects. 
 

 
 
If a given tie defect is severe enough that its station location or condition level 
should be noted for a potential work order, the  button 
displays the field for entering this information. 
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Rail Inspection 
Rail inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the rail inspection screen, right click on 
the segment of interest, then choose Inspection -> Detailed.  The rail tab contains 
a grid, with each row of the grid representing defects for that segment on a given 
inspection date.  Rail inspection information can be viewed for any inspection on 
record in the database by using the Date drop down box, and choosing the date 
of the inspection. 
 

 
 
To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  Note 
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that the Defect Free check box is used to denote the segment as inspected and 
completely free of rail defects.  In addition, the Non-destructive test check box is 
used if the rail inspection was conducted using NDT methods. 

Other Track Materials 
OTM inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the OTM inspection screen, right click 
on the segment of interest, then choose Inspection -> Detailed.  The OTM tab 
contains a grid, with each row of the grid representing defects for that segment 
on a given inspection date.  OTM inspection information can be viewed for any 
inspection on record in the database by using the Date drop down box, and 
choosing the date of the inspection. 
 

 
 
To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  Note 
that the Defect Free check box is used to denote the segment as inspected and 
completely free of OTM defects.  In addition, the Non-destructive test check box 
is used if the OTM inspection was conducted using NDT methods. 

Appliance Inspection 
Appliance inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the Appliance inspection screen, right 
click on the segment of interest, then choose Inspection -> Detailed.  The 
Appliance tab contains a grid, with each row of the grid representing defects for 
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that segment on a given inspection date.  Appliance inspection information can 
be viewed for any inspection on record in the database by using the Date drop 
down box, and choosing the date of the inspection. 
 

 
 
To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  When 
inputting appliance defects, note that the Station field is a drop list which displays 
the location of all appliances in the inventory for that segment. 

Rail Crossing Inspection 
Rail Crossing inspection screen, right click on the segment of interest, then 
choose Inspection -> Detailed.  The Rail Crossing tab contains a grid, with each 
row of the grid representing defects for that segment on a given inspection date. 
 Rail Crossing inspection information can be viewed for any inspection on record 
in the database by using the Date drop down box, and choosing the date of the 
inspection. 
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To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  When 
inputting rail crossing defects, note that the Station field is a drop list which 
displays the location of any rail crossing in the inventory for that segment.  In 
addition, the Flangeway Measurements tab contains information about rail 
crossing flangeway width and depth measurements. 

Ballast/Subgrade Inspection 
Ballast/Subgrade inspection information, as with all inspection information, is 
stored and accessed at a segment level.  To access the Ballast/Subgrade 
inspection screen, right click on the segment of interest, then choose Inspection -
> Detailed.  The Ballast/Subgrade tab contains a grid, with each row of the grid 
representing defects for that segment on a given inspection date. 
 Ballast/Subgrade inspection information can be viewed for any inspection on 
record in the database by using the Date drop down box, and choosing the date 
of the inspection. 
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To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  Note 
that the Defect Free check box is used to denote the segment as inspected and 
completely free of Ballast/Subgrade defects. 

Drainage Inspection 
Drainage inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the Drainage inspection screen, right 
click on the segment of interest, then choose Inspection -> Detailed.  The 
Drainage tab contains a grid, with each row of the grid representing defects for 
that segment on a given inspection date.  Drainage inspection information can be 
viewed for any inspection on record in the database by using the Date drop down 
box, and choosing the date of the inspection. 
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To insert additional defects for an inspection record (on a given date), click the 

 button to insert additional rows to the grid.  To delete a defect from 
the inspection record, highlight the row, and click the  button.  When 
inputting Drainage defects, note that the Station field is a drop list which displays 
the location of all appliances in the inventory for that segment. 

Impaired Inspection 
Impaired Inspection information, as with all inspection information, is stored and 
accessed at a segment level.  Impaired inspection denotes that the inspection 
process was impaired due to external circumstances, such as cars on the track. 
 To access the Impaired Inspection screen, right click on the segment of interest, 
then choose Inspection -> Detailed.  The Impaired Inspection tab contains a grid, 
with each row of the grid representing the locations of impairment for that 
segment on a given inspection date.  Impaired Inspection information can be 
viewed for any inspection on record in the database by using the Date drop down 
box, and choosing the date of the inspection. 
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. 
 
To insert additional impaired locations for an inspection record (on a given date), 
click the  button to insert additional rows to the grid.  To delete a 
location from the inspection record, highlight the row, and click the  
button. 

Geometry Inspection 
Geometry inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the Geometry inspection screen, right 
click on the segment of interest, then choose Inspection -> Detailed.  The 
Geometry tab contains 5 sub-tabs for alignment, crosslevel, displacement, 
gauge, and profile geometry deviations.  Each sub-tab contains a grid, with each 
row of the grid representing geometry deviation measurements for that segment 
on a given inspection date.  Geometry inspection information can be viewed for 
any inspection on record in the database by using the Date drop down box, and 
choosing the date of the inspection. 
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To insert additional deviation measurements for an inspection record (on a given 
date), click the  button to insert additional rows to the grid.  To delete 
a deviation measurement from the inspection record, highlight the row, and click 
the  button.  Note that the Defect Free check box is used to denote 
the segment as inspected and completely free of all geometry deviations.  In 
addition, the Operational Inspection check box is used if the geometry inspection 
was conducted in conjunction with train operations. 

Grade Crossing Inspection 
Grade Crossing inspection information, as with all inspection information, is 
stored and accessed at a segment level.  To access the Grade Crossing 
inspection screen, right click on the segment of interest, then choose Inspection -
> Detailed.  The Geometry tab allows you to bring up a grade crossing's 
inspection records by choosing either the crossing centerline station or road 
name from the corresponding drop down boxes.  The Crossing Defects sub-tab 
contains a grid, with each row of the grid representing grade crossing defects for 
the selected grade crossing on a given inspection date.   
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To insert additional grade crossing defects for a grade crossing inspection record 
(on a given date), click the  button to insert additional rows to the grid. 
 To delete a grade crossing from the inspection record, highlight the row, and 
click the  button.  Note that the Defect Free check box is used to 
denote the grade crossing as inspected and completely free of all defects.  In 
addition, the Flangeway Measurements tab contains information about grade 
crossing flangeway width and depth measurements.  Finally, the General 
Observations and Measurements tab (shown below) contains additional 
observations about the condition of the grade crossing in terms of ride quality, 
sight distance, track profile, and approach elevation. 
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Turnout Inspection 
Turnout inspection information, as with all inspection information, is stored and 
accessed at a segment level.  To access the Turnout inspection screen, right 
click on the segment of interest, then choose Inspection -> Detailed.  To view or 
edit the turnout inspection record for another turnout, choose the turnout ID from 
the drop down list.  The General Observation tab (below) displays general 
information about the condition of the turnout. 
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The Switch Ties tab (below) displays information about the defective switch ties 
in the turnout selected.  An individual switch tie can be marked as defective, 
defective joint, missing, or improperly positioned (skewed).  In addition, the size 
of each defective tie can be noted in the tie grid. 
 

 
 
The switch tab (below), frog tab, and guardrail tab each contain a list of their 
respective components, and the possible defects associated with each, arrange 
in a grid format.  A defect can be noted by checking the box or indicating the 
number of defective components of a given defect type are present in the 
turnout.  In addition, the switch, frog, and guardrail all have measurements that 
can be recorded on the corresponding tab. 
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Safety Inspection 
Safety Inspections 
Unlike a detail inspection which addressed all defects, a safety inspection usually 
only addresses the most critical defects types which should be corrected in an 
expedient fashion.  Safety inspection information, as with all inspection 
information, is stored and accessed at a segment level.  To access the safety 
inspection screen, right click on the segment of interest, then choose Inspection -
> Safety.  The Safety Inspection screen contains a grid, with each row of the grid 
representing safety defects for that segment. 
 

 
 
To insert additional safety defects, click the  button to insert additional 
rows to the grid.  To delete a safety defect from the segment record, highlight the 
row, and click the  button.  The safety grid shows all defects 
previously recorded, regardless of the date they were found.  Use the Show 
Existing Defects and Show Fixed Defects check boxes to display only current 
safety defects that exist on the track, only safety defects that have been fixed, or 
all safety defects identified.   
 
Safety Inspection may occur on a monthly, or more frequent, schedule.  If safety 
defects have been identified via a previous inspection, and those defects are still 
found to be present under the next safety inspection, it is not necessary to enter 
those defects again - the system already has those recorded as existing defects. 
 If a safety inspection is performed that turns up no new safety defects, a new 
record show be entered for that inspection date where the component is set to 
none - denoting no defects. 
 
During a detailed inspection, it is not unlikely to come across a critical defect that 
requires a immediate work action because it is a safety concern.  If a given 
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defect is denoted as requiring a work order during the detailed inspection, that 
defect will be displayed on the safety screen as well. 
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Uninspected Deteriorated 
Uninspected Deteriorated 
The Uninspected Deteriorated screen is accessible from the tree right click 
menu, then choosing Inspection -> Uninspected Deteriorated.  This inspection 
option is available for tracks/segments whose condition is so poor that is its not 
worthwhile to inspect.  In this situation, ultimately the track or segment requires 
total reconstruction. 
 

 
 
To create a new Uninspected Deterioration record for a segment: 
1.  Highlight the track or segment from the tree, right click and choose Inspection 
-> Uninspected Deterioration 
2.  Click the New  button 
3.  Chose the date and inspector 
4.  Click the Save  button 
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Certification 
Track Certification 
For Navy installation track, certification records must be kept to indicate if each 
track and track segment is Certified, Restricted Certification, or Closed to Traffic. 
 This certification is based off of the finding of the detailed and/or safety track 
inspections and is signed by the inspector and certifying official, usually the 
garrison commander.  RAILER can automatically produce a certification record 
using recent track inspection results.  This record can be electronically signed 
and saved for retrieval at a later point in time. 
 

 
 
To open the certification screen for a track, right click on the track (or segment) 
and choose Certification.  The certification window will come up, and a new 
certification record can be generated by clicking the New button .  This lists 
the certification level by component, as well as a description on critical or 
catastrophic defects.  The inspector and certifier can each change the default 
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recommendations if necessary, and then click the Sign button  individually to 
sign the record.  Note that an inspector or certifying official must be logged in as 
a user with the appropriate user privileges to use the electronic signature feature. 
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Work Planning 
Configuration 
Costs 

The Costs screen is available from the Work Planning -> Configuration -> Costs 
menu.  Users can create customized cost books of track repair work actions 
based on expected or contracted unit prices.  These costs are then used in the 
work plan development process.   
 
Work actions in RAILER are divided into Local and Global actions.  Local work 
actions correct specific defects present on the track, and are applied at the local 
location where that defect is present.  Global work actions are applied to an 
entire segment or track, regardless of the defects present on that track.  For 
example, you may have a global  work action to upgrade to a heavier rail section 
on a portion of track, regardless of the defects in that rail.  Work actions and 
costs for either local or global actions are accessed using the Cost Scope radio 
button.  In addition to unit cost information, the contract work action line item can 
be optionally stored. 
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RAILER allows for the creation of Method of Accomplishment (MOA) cost books. 
 To view cost data for a given cost book, use the MOA drop list.  To create a new 
cost book, click the New  button.  To copy an existing cost book along with all 
cost information, click the Copy  button.  To delete a cost book, select the cost 
book from the MOA drop list, and click the Delete  button.  To export cost data 
to Microsoft Excel, click the Export to Excel button. 
 

Inflation 

When creating Multi-year work plans in RAILER, it is important to forecast the 
costs for work actions in out years.  Therefore, the user can adjust the factor to 
inflate the unit costs for each year.  Inflation factors are accessed from the Work 
Planning -> Configuration -> Inflation menu. 
 

 

Policies 

Policies in RAILER link a given defect with a corrective work action.  For 
example, if a defective 5-in-a-row tie cluster is present on the track, numerous 
options exist for addressing the problem.  One option could be to replace all ties, 
while another option could be to replace only the center tie.  Each action has a 
different cost and level of repair effort, and each may be viable for a particular 
portion of track.  The RAILER work planning module uses this information to 
automatically determine what work action to use to corrective an existing defect 
when generating a work plan. 
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In RAILER, multiple maintenance and repair policies can be created.  For 
example, there may be a minimum repair policy, a complete repair policy, or a 
best practice policy.  New policies are created by click the New  button on the 
toolbar.  A selected policy can be copied over to a new policy by clicking the 
Copy  button.  A selected policy is deleted by clicking the Delete  button. 
 
When a policy is created or edited, each defect in RAILER is shown in the 
description column.  The work action to be applied for that defect can be set by 
clicking on the corresponding cell in the Work Action column, and choosing the 
appropriate work action from the drop list.  In addition, the Std. Condition column 
lists the standard condition level for each defect based off of the standard 
displayed in the Standard drop box.  If the user wanted to treat a given defect as 
a more serious defect against the standard, they could use the M&R Trigger 
column to lower the standard condition level.  For example, even though a 
defective joint tie provides no restriction against the standard, the user could set 
the joint tie defect to be treated as a restricted operations defect for the purposes 
of that policy. 

Prioritization 

When work plans are developed, many times the cost of all suggested work 
actions exceeds the total budget.  In this case, work item ranking is necessary to 
determine which items are the most critical to be accomplished under those 
budget constraints.  A prioritization scheme establishes an organized framework 
for determining project and work item priorities and rankings based off of set user 
criteria. 
 
The prioritization screen is accessed from the Work Planning -> Configuration -> 
Prioritization menu.   
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The first step to creating a prioritization scheme is to create a new criteria set: 

1. Click the New  button on the toolbar, and type the criteria set ID in the 
box. 

2. Specify the criteria to be used by clicking the Choose Criteria button, and 
checking the box on the criteria to be included 

3. Then use the slider bars to determine the relative weight of each criteria 
on a scale of 1-10. 

4. When finished creating the criteria set, click Save. 
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Once the criteria to be used is specified, then impact factors can be assigned as 
measures of importance for each value or range for the criteria.  From the 
example scheme below, the FRA standard was specified as a criterion, and all 
segments at the FRA standard level of Below class one will get the highest 
priority (an impact of 5).  Likewise, segments at a FRA standard condition level 
than exceeds class 3 will only get the lowest priority (impact of 1).  By looking at 
the attributes of each segment, and scoring those attributes base on the criteria 
and impacts specified in the prioritization scheme, RAILER can automatically 
computer priority rankings for maintenance and repair work actions. 
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Funding 

The funding screen is accessed from the Work Planning -> Configuration -> 
Funding menu.  RAILER allows for the creation of several funding schemes, 
which can be viewed from the Funding Scheme drop list. To add a funding 
scheme, click the New  button.  To copy and existing funding scheme along 
with funding information, click the Copy  button.  To delete a funding scheme, 
select the it from the Funding Scheme drop list, and click the Delete  button. 
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Funding sources can be added to a given funding scheme by clicking the Add 
Funding Source button.  A funding source can be deleted by clicking the Delete 
Funding Source button.  Once the expected funding for each year is specified, 
RAILER's work planning module can use that information in the creation of multi-
year work plans to determine which work actions can be accomplished and which 
will be deferred based on their cost and priority. 

M&R Plan 
Work Plan Generation 

Once inspection information is loaded into the system, and the work planning 
configuration modules (including costs, inflation, policies, prioritization, and 
funding) are set up, the work plan generation process can begin.  The 
Maintenance & Repair (M&R) screen can be accessed from the Work Planning 
menu and choosing M&R Plan.  The General tab allow for the creation and setup 
of an M&R plan. 
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A new plan can be created by clicking the New  button.  An existing plan can 
be selected from the Plan ID drop down, and that plan can be copied to a new 
plan by clicking the Copy  button.  In addition, an existing plan can be deleted 
by clicking the Delete  button.  For each plan, the user specifies the following 
general information: 
 
Plan Start Year:  The first year the M&R plan take effect 
Plan Horizon:  How many years the plan will cover 
Target Condition Level:  The target level based off of standards restrictions that 
the track will be at after plan is complete 
Local M&R Policy:  The M&R policy for use by the plan 
Method of Accomplishment:  The cost book for use by the plan 
Prioritization Scheme:  The prioritization scheme for use by the plan 
Funding Scheme:  The funding scheme for use by the plan 
Components:  The plan can be configured to address only specific track 
components as chosen 
Network Scope:  The plan can be configured to address only specific areas, 
track, or segments as chosen 
Global M&R actions:  Global M&R work to be incorporated into the plan is 
selected here. 
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Once the plan configuration has been set, it can be saved by clicking the Save 
 button.  Work plan work items are then generated by clicking the Generate 

Items  button.  The program will go through the database of defects for the 
segments and components selected in the work plan and compare each defect to 
the target condition level.  Each defect below the target condition level will get 
added to the work item list (below), along with the associated work action and its 
cost from the designated cost book.  Work items are grouped by segment-
component (for example Track 3 Tie work).  Clicking the plus [+] expands the 
grouping to show all work items in that grouping. 
 

 
 
To prioritize all work items based on the criteria established in the Prioritization 
scheme, click the Prioritize  button.  This will compute a priority score for all 
work items.  If running a multi-year plan, (horizon greater than 1 year) the 
Funding  button can be used to initially fund work items based on the 
projected budget levels defined for the Funding scheme.  For example, the 
program will look at work items rankings based on priority score, and fund the 
highest priority items until first year funds get allocated.  Then it will inflate 
unfunded work items to the next year based on the Inflation factors, and fund 
remaining highest priority items for each year until the designated funds get 
expended.  This process determines the work year for each work item.  Note that 
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the user can adjust and overwrite any of the fields in the work plan to account for 
special circumstances. 

Projects 

After a work plan has been developed which generates a list potential work 
actions, a project, or multiple projects, can be created to group work actions into 
executable packages.  These projects are tracked, budgeted, and executed 
together.  The list of projects can be viewed by clicking the Projects button  on 
the M&R Work Plan screen.  The grid displays project information, such as 
project name, description, work request number, project order number, status, 
completion date, etc.   
 

 
 
A new project can be created by clicking the new project button, and entering the 
project information in the grid.  Clicking the details button or double clicking on a 
project's row brings up the project development window for that project.   
 

 
 
Summary information as discussed above is on the Summary tab for the Project 
Development window, and Detailed information about work actions included in 
the project is on the Detailed tab.  To associate work actions with a project from 
the detailed tab, select the work action from the lower window, and click the up 
arrow to include it in the project.  A work action can also be removed by clicking 
the down arrow after selecting it from the top window.  In addition, work items 
can be associated to a project through the main Work Items grid by selecting the 
project name from the project drop down. 
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Work History 

After project work has been finished, the project status can be moved to 
completed and a completion date entered for the project through the project 
screen in M&R work plan.  After doing this the Historical check box can be 
checked to transfer the project information to work history.  This creates a 
historical record of all work that has been completed.  In addition, Condition 
Index values and Standard Operations Restrictions are re-computed based on 
the work items in the project having been completed, and the associated defects 
no longer existing. 
 

 
 

63 



RAILER SMS 6.0 User Manual 

After a project has been transferred to work history, it can be viewed through the 
Work Planning -> Work History window. 
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Reporting 
Reports Query 

When the user clicks the Reports  button, the reports query tool is displayed. 
 This tool allows the user to create filters to select only a portion of the records in 
the report be displayed based off of user-defined criteria.  In the example below, 
the report while return only segments where the TSCI is less than 80.  Once the 
criteria has been chosen, click the OK button to run and display the report 
results.  
 

 

Spreadsheet Reports 

When the user clicks the Reports  button from the Network, Area, Track, or 
Segment screen, a spreadsheet style report is generated, where information is 
displayed in the report viewer in a tabular format.  Note that prior to the report 
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viewer screen, the Reports Query screen is displayed to define the scope of the 
report. 
 

 
 
Spreadsheet style reports can be grouped by a a given field by dragging the 
column header of that field into the space above.  Click the plus [+] next to the 
group to expand info for that group.  Reports can also be sorted by column by 
clicking the column header to sort ascending or descending.   
 

 
 
Finally, clicking the Export to Excel  button will export report information to 
Microsoft Excel. 

Fixed Format Reports 
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When the user clicks the Reports  button from the Inventory or Inspection 
screens, they are presented with the option of running a spreadsheet report or 
fixed format report.  Spreadsheet style reports are tabular reports as discussed 
here. 
Fixed format reports are formatted in a printable style.  After choosing a fixed 
format report, the Reports Query screen will be displayed as with the 
spreadsheet style reports.  After entering the select criteria, the following screen 
is displayed: 
 

 
 
The user can choose to Print the report, or Preview a copy of the printed report 
with the Preview Button: 
 
RAILER fixed format reports include: 
 
Detailed Inspection Report:  From the inspection screen, this report shows a 
detailed printout for an inspection record. 
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Track Inventory Location Report:  From the inventory screen, this report shows 
a list of inventory component items arranged by station location. 
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Consolidated Inventory Report:  From the inventory screen, this report shows 
a detailed account of all inventory component and track attributes for a given 
track. 
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Condition Analysis Reports 
Condition Analysis reports are access from the Reports menu in RAILER. 
 Condition Analysis reports include: 
 
Condition Index:  A breakdown of track segments in the network by TSCI 
ranges 
ISR:  A breakdown of track segments in the network by Army Installation Status 
Ratings, using information from the TSCI values 
Standard Level:  A breakdown of track segments in the network by operating 
restriction levels imposed by standards. 
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Each report shows a summary of information about the number of segments and 
total track length that fall into each category.  The chart displays the results 
breakdown for the highlighted row. 
 

 
 
In addition, the Details view displays the detailed information about each 
segment, as shown below. 
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Updating Condition Indices (CI) 
Calculating Condition Indices 
After an inspection is completed, RAILER can use that inspection information to 
calculate the condition indices (RJCI, TCI, BSCI, and GCCI) for each segment, 
and roll-those CIs up into the TSCI for each segment, track, area, and network. 
 It will also calculate the standard condition level for each segment based off of 
the primary standard. 
 
To recalculate CIs in RAILER: 

1. Choose CI Update from the Analysis menu.  The Recalculate Condition 
Level screen will appear. 

2. CIs can be computed for a single track or segment, or for all tracks and 
segments. 

3. Click the Recalculate button.  This operation could take several minutes to 
complete. 
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Support 
Sources of RAILER Support 

University of Illinois 
 
If RAILER software was obtained from the University of Illinois, contact the 
following for software support: 

Scott McDonald 
Tel: (800)895-9345 
Email: techctr@uiuc.edu 
University of Illinois Technical Support Center 
302 East John Street, Suite 302 
Champaign, IL 61820 

 
 

SMS Center of Expertise for RAILER 
 
The SMS Center of Expertise for Builder was created to provide a full range of 
customer support to DoD RAILER users. Services include: 

• Support for implementation of RAILER 
• Support for Inspection and re-inspection of Railroad track 
• Condition assessment analysis 
• Technical support for RAILER users 
• Training 
• Development of annual and long range work plans 
• Budget forecasting and justification 
• Development of GIS applications and presentations 
• Database maintenance 
• Software customization for specific organization requirements 

 
The SMS POC for RAILER implementation is: 

Michael Grussing, P.E. 
Civil Engineer/Principle Investigator 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.398.5307 
Email: michael.n.grussing@erdc.usace.army.mil 
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Software Development 

Engineer Research and Development Center - Construction 
Engineering Research Labs (ERDC-CERL) 
 
The Principles on RAILER development are: 

Michael Grussing, P.E. 
Civil Engineer/Principle Investigator 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.398.5307 
Email: michael.n.grussing@erdc.usace.army.mil 
 
 
Lance Marrano 
System Engineer/Project Manager 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.373.4465 
Email: lance.r.marrano@erdc.usace.army.mil 
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Disclaimer 
This program is furnished by the U.S. Army Corps of Engineers Engineering 
Research and Development Center - Construction Engineering Research 
Laboratory (ERDC-CERL) and is accepted and used by the recipient with the 
express understanding that the United States Government, the U.S. Army Corps 
of Engineers, and ERDC-CERL make no warranties, expressed or implied, 
concerning the accuracy, completeness, reliability, usability, or suitability for any 
particular purpose of the information and data contained in this program or 
furnished in connection therewith, and the United States shall be under no 
liability whatsoever to any person by reason of any use made thereof. This 
program is a property of the ERDC-CERL. The recipient agrees not to assert any 
proprietary rights therein or to represent this program to anyone as other than a 
government property; furthermore, this program can only be copied for legitimate 
backup purposes by the user. 
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